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1.  Getting started 

What is EndNote  

EndNote is a reference management service which enables you to: 
● Store and organise references, PDFs and images 
● Create in-text citations in Word documents  
● Create formatted bibliographies 
● Import references from online databases and catalogues. 

 
EndNote is available on all the university networked computers, You can also download to 
your own computer via Brookes ‘Apps Anywhere’.  Further details on the library website at: 
http://www.brookes.ac.uk/library/how-to/use-endnote/ 

Starting EndNote and creating a new library 

● Log on to a PC in a pooled computer room, or the library (or your own pc). If you are 
on a networked pc, ignore any installation message 

● Select the box icon, bottom left of screen, and select EndNote 
● Once EndNote has opened, click File, top left of screen 
● Select New. Your collection of references is known as a library. We recommend that 

you only have one library. Name and save your library.  

Navigating around your library 

● You can navigate around your library using the top toolbar which has various options, 
eg File, Edit, References, Help  

● You can also use the icon commands, located above the central panel of your library 
● Use the Help option to search for a topic or browse the contents and index. 
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Opening and closing your EndNote library 

● Select File and Open to open your existing library. On your own pc you can set your 
library to open automatically: Open EndNote Desktop. Select Open and choose your 
library. Go to Edit. Select Preferences and Libraries.  

● Select your preferred option from the drop-down menu. Click OK. 
● To close your library, select File and Exit or click the red X, top right of screen. 

2. EndNote library layout  

The library window includes three panels – References (middle), Groups (left), Tabs. 

The References panel (centre) displays a multi-column list of your references  
 

● By default, the first column shows a paper clip icon for references that include an 
attached file, followed by: first author’s last name, year, title, rating, journal name, last 
updated date and reference type. Reorder the heading columns using drag and drop. 
 

 Customising your reference list panel: from the Edit menu, select Preferences 
 

● Click the Display Fields option in the list. Select the desired field from the Field list. 
You may select up to ten fields to be displayed. Select ‘Do not display’ instead of a 
field name if you want to show fewer than eight fields  

● By default, the column heading in the library window will be the same as the generic 
name of the field (the File Attachments field is indicated by a paper clip) 

● If you would like to change the name for the library window display, you can do so by 
entering a new name in the Heading section next to the chosen field 

● Click OK to save the changes and close the Preferences box. 
 

The Groups panel on the left of the window contains groups of references - see section 5.  

 

The Tabs panel includes three tabs: Reference, Preview and Attached PDFs  
 

● Select Reference to view and edit the details of a selected reference 
● Select Preview to view the formatted style of the selected reference  
● Use the Output Styles menu on the Main toolbar to change the style. Alternatively, 

from the Edit menu, select Output Styles and select a style in the list. Select Open 
Style Manager to view and select more styles 

● Select PDF to view and annotate any attached PDFs. EndNote allows you to open, 
preview, and annotate PDF files within this Attached PDFs panel. 

3. Adding references to your EndNote library manually 

You can add references to your library manually or automatically. To add a reference 
manually you can type in the details or cut and paste: 
 

● Click on References, select New Reference. This opens an empty reference window 
● Select a reference type from the drop-down menu 
● Enter the details of your reference. Use the tab or shift tab key to move up and down 

between the different fields 
● Click on File and select Save to save your reference or close your reference window 
● Double click on a reference to edit it. Alternatively highlight the reference and select 

References and Edit References. 

Entering information into the reference fields: 
 

 Authors: Type one author name on a line. Click Enter to insert more lines 
 

● Put a space between first and last names eg Kelly, John  OR  Kelly, J. K. 
● Organizations must be entered with a comma at the end 
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● You can select Tools and ‘Open term lists’ to view authors already used. 
 
Keywords: You can use semi-colons or backslashes to separate your keywords 

● You can select Tools and ‘Open term lists’ to view keywords already used. 
 

Journals: You can select Tools and ‘Open term lists’ to view journals already used. 
 
Adding an attachment 

● Open your reference and click the paperclip symbol in the toolbar. Select the file to 
attach, click Open. The file is located in the file attachments field of the reference. 

   
Adding your own notes  

● You can use the research notes field of a reference to add your own notes. 

4. Adding references to your EndNote library automatically 

You can transfer a set of references from an online resource, eg a database automatically. 
Some databases offer the option of exporting directly into EndNote, in others you need to 
save records and then import them. You can also transfer references from our LibrarySearch 
into EndNote. Details of how to do this are available on our web pages at: 
www.brookes.ac.uk/library/how-to/use-endnote/ Scroll down to the ‘Add references’ section. 
 
It is important to check your imported references. Double click on a reference to view and 
edit it. Alternatively highlight the reference and select References and Edit References. You 
can also add any additional information you want to include, for example, you can use the 
research notes field to add your own notes and where you found the reference. 

5. Groups - including find full text option 

You can save your references to a group/s to help organise your library in a meaningful way. 
The left panel of the library window lists groups of your references. You can build your own 
(custom) group/s as well as using the permanent groups. The following groups are 
permanent and you cannot remove them: 
 

● All References displays all the references in the library 
● Unfiled contains the references that are not part of your custom groups  
● Trash references that have been deleted but not yet permanently discarded. 

 

My Groups (custom groups) built by specifically adding individual references to the group: 

Create a group: 
 

● Click Groups, top of screen, select Create Group 
● In the Groups panel of the library window, a group titled New Group is now 

highlighted. Type the group name of your choice and press enter  
● To add references to your group, click on the All References group to display all your 

references. Highlight the references you want to add to the group 
● Drag the selected (highlighted) references to the group and drop them on the title of 

the group. Alternatively, go to the Groups menu and choose ‘Add References To’.  

Rename or delete a group: 

● Select the group. Click Groups, top of screen. You can rename or delete that group. 
 
 Group Sets: Further organize your references by storing a number of groups in sets: 
 

● Select Create Group Set from the Groups menu. Type in a name. Groups can be 
dragged to move them to the new group set. 

http://www.brookes.ac.uk/library/how-to/use-endnote/
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Find Full Text: To use this feature, highlight the reference/s of your choice. From the 

References menu, select Find Full Text. Temporary groups appear when this command is 
selected. The groups remain for the current session:  
 

● Searching – the number of references for which EndNote is trying to find full text  
● Found PDF – those references for which a full text PDF has been found and inserted 
● Found URL - those references for which a URL has been found and inserted 
● Not found – the number of references for which no full text has been identified 

 
Do be aware that this feature will not find all the full text files that are available to you 
through the library subscriptions. Search for the journal title on our ‘Journal titles’ option on 
the library webpages to check if an article is available full text.  

6. Linking a PDF / file / image to an EndNote reference 

You can link a file on your computer, eg a PDF file, image, or spreadsheet, to an EndNote 
reference. This File Attachment option is available only when a single reference is selected 
or when you are editing a reference. 
 

● Select a reference in the library window, or open the reference 
● From the References menu, select File Attachments and select Attach File. Select a 

file to link to your selected reference 
● Alternatively, open your reference and click the paperclip symbol. Select the file to 

attach, click Open. The file is located in the file attachments field of the reference. 
 

Note the check box at the bottom entitled, "Copy this file to the default file attachments folder 
and create a relative link." This gives you the option to:  
 

● Select the check box to copy the original file and place the copy in the DATA\PDF 
folder that is part of your EndNote library (this is known as the Relative Path or link) 

● Deselect the check box to always have EndNote look in the original folder for the 
inserted file (known as the Absolute Path or link) – this can be helpful if you want to 
edit the original file and you want those changes reflected when you access the file 
from within EndNote. However, if you move the file from the original folder, EndNote 
will not be able to access it unless you clear the file from your EndNote reference and 
reinsert it from the new folder location. Note: if you choose this option, you need to 
open your reference first (double click on your selected reference). 

7.  Searching and sorting your library 

Searching your library: 

● Select the group of references you want to search. Select Tools from the list of 
options, top of screen, and then select Search Library  

● You can also search by selecting the Show Search Panel button to display the 
Search panel. Select Hide Search Panel to hide the Search panel from view 

● There is also a Quick Search option next to the toolbar. You can use this option to 
search your entire library including PDFs by typing a single word or a phrase into the 
text box. EndNote uses an implied AND when you enter 2 or more words. Use 
double quotation marks (" ") to search for exact phrases. 

Sorting your References 

● References can be easily sorted by clicking on a column heading, above your list of 
references, eg Author, Year, or Title. The default is A-Z author order 
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● Select Tools and Sort Library to choose up to five fields for custom sorting. This 
enables you to arrange all your references for browsing, copying or printing. 

Previewing your References in a chosen output style 

● Highlight a reference. Click on Preview (in the Tab panel). Your reference details are 
displayed in the selected output style. You can change the output style by clicking the 
drop-down arrow to the right of the output styles box above your references list. 

8.  Searching online databases from within EndNote 

You can connect directly to various online resources (databases and library catalogues) 
using EndNote's Online search feature. Although EndNote supplies hundreds of links to 
databases, many of these will not work for Oxford Brookes users via this route - either 
because the library does not subscribe to the database or because the link is pointing to a 
server to which we do not have access.  
 
Links which do work from within EndNote include the British Library Catalogue and Web of 
Science. Consult the section on adding references to your library on our EndNote webpage 
for further details: http://www.brookes.ac.uk/library/how-to/use-endnote/ 
 
Remember: to use many of our databases with EndNote, you need to search the database 
itself and transfer the references from the database into EndNote rather than searching from 
within EndNote. See the section on adding references to your library on our webpage for 
further details: http://www.brookes.ac.uk/library/how-to/use-endnote/ 

Connecting to an online resource from EndNote: 

● From the Tools menu in EndNote, select Online Search 
● Highlight a library catalogue or database from the list. Click Choose 
● The left-hand panel of your EndNote Library now has an Online Search heading. The 

name of the resource that you are searching is highlighted  
● Use the search boxes to carry out your search. The number of references which 

match your search will appear on the screen 
● Click OK and the references will be displayed in your library window. Highlight any 

references you want to save, go to the References menu and select ‘Copy 
references’. Select your library 

● Click the book icon below your top toolbar to exit from the online search mode and 
return to your local library mode. 

 

9.  Creating a bibliography / in-text citations  

You can create a bibliography and add in-text citations to your Word document (e.g. essay 
or dissertation), formatted in whatever bibliographic style you choose. 

Citing references in your text 

● Open your document in Word. Position the cursor in the text where you want the 
citation to be. Leave a single space between the text and the cursor 

● Select EndNote from the list of options top of screen. A number of options are 
displayed, select ‘Insert Citation’ (If you cannot see the EndNote option displayed, 
select Add-ins and select EndNote) 

● A ‘Find Citation’ window will appear (it may display a previous search which you can 
delete). If you did not open EndNote initially you will now be prompted to do so.  
NB If you are on a university networked computer and it is unable to find your 

http://www.brookes.ac.uk/library/how-to/use-endnote/
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EndNote library, you need to check that Word is linking to EndNote Desktop and not 
EndNote online. To do this, select ‘Preferences’ and ‘Application’ Click the arrow next 
to ‘Application’ and select EndNote (not EndNote online) 

● In the Find box, enter a search term to find the reference(s) you need. Click Find. 
The references which match your search are displayed on the screen 

● When you highlight a reference, the reference details appear in the lower screen 
● Select the reference you want to insert in your text by highlighting it and click Insert.  

Unformatted references (a number appears next to your in-text citation) 

● When a reference is added to your EndNote library it is given its own unique number  
● When you add an in-text reference from your library to your Word document it will 

appear with a number next to it if your document is not formatted. Your bibliography 
also will not appear. You need to format your references to display your document in 
the style of your choice (and remove the reference number). 

Formatting your references (selecting a style for your document)  

● In Word select EndNote Desktop, select your output style. You can click the drop-
down arrow to the right of Style to view a list of available styles. Choose ‘Select 
Another Style’ if the style you want is not listed – in the display window, you can click 
Name to view an alphabetical list of styles  

● Select ‘Update Citations and Bibliography’. The citation will appear in the text of your 
document, and in a bibliography at the end.  

 
Many departments at Brookes recommend using a particular style, check with them which 
one you should use. A commonly used style is Harvard.  
 

Oxford Brookes Library has created two customised Harvard styles. These are available on 
the pooled room versions of EndNote and referred to as BrookesHarvard and 
BrookesHarvardAllAuthors. Select the ‘AllAuthors’ option if you need to include all the 
authors of a piece of work in your reference list.   
 
If you are using your own PC you can download these output styles from 
http://www.brookes.ac.uk/library/how-to/use-endnote/ Scroll down to the ‘Creating 
bibliographies’ section and select ‘Getting the BrookesHarvard style’. 

Creating a stand-alone (independent) bibliography 

There are various ways to create an independent bibliography. The Help feature in EndNote 
provides further information. One option is detailed below. 
 

● In EndNote, open your library of references. You need to choose the output style for 
your bibliography - above your list of references you will see the current output style 
displayed. Use the drop-down menu to select another style. Highlight the style you 
require and click Choose 
 

● Select the references you want in your bibliography - you can either do this from your 
complete references list or use the search facility to create a subset of references 
 

● To select records which appear consecutively, click on the first reference and hold 
down the Shift key to highlight a batch of references. To select separate references, 
click on the first reference, hold down the Ctrl key and click further references  
 

● You can now copy these selected references into your Word document. Choose Edit 
(from your EndNote toolbar) and select ‘Copy Formatted’  
 

● Open your Word document and put the cursor where you want your bibliography to 
start and paste in your selected references. 

http://www.brookes.ac.uk/library/how-to/use-endnote/
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10. Sync Feature 

The Sync feature allows you to synchronize the references (including file and figure 
attachments) in your EndNote desktop library with the references in your EndNote online 
library. You must have an active EndNote online account to initiate the Sync process. This 
online account is also known as EndNote Web. You can set up an online account for free as 
a member of Oxford Brookes University. Consult our EndNote webpage (the section on 
‘getting started’) for further details: http://www.brookes.ac.uk/library/how-to/use-endnote/ 

Using the sync feature 
 

● Click the Sync button in the toolbar (blue circle with 2 arrows) to go to the EndNote 
login. Enter your EndNote e-mail address and password. Click OK 

● The Sync process should automatically begin synchronizing your desktop references 
with your EndNote online references so that an exact match exists in both libraries. 

 
Note: The library that you want to sync must be open and currently active to perform the 
Sync process. You cannot initiate the Sync process in Online Mode.  

11.  Further help 

 

● EndNote provides detailed online help. Select the Help option top of screen. You can 
look at a list of contents or search for words or phrases 
 

● Visit our Library web page at http://www.brookes.ac.uk/library/how-to/use-endnote/ 
 

● Contact us via email if you have a query or would like additional help: 
lr-endnote@brookes.ac.uk 

 

● Contact your librarian – details are available from the library’s webpages at: 
https://www.brookes.ac.uk/library/resources-and-services/course-resource-help 
 

 
 

Helen Whittaker, 9/18 updated Jo Akers and Helen Whittaker 08/21 
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